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1 软件运行环境 

表 1-1 软件运行环境 

Windows 
Win7/8/10 (64bit) 
Win7/WinXP (32bit) 
Windows Server 2008 R2 

Linux 
Centos6/7 (64bit) 
Ubuntu18.04 LTS 
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2 软件下载 

云源软件安装包以及浮点型 license 服务启动软件 Gowin License 

Server，分为 Windows 版本和 Linux 版本，可通过官网下载： 

www.gowinsemi.cn/faq.aspx 

 Windows 系统下的云源软件安装包名称为“云源软件 for 

win(Vx.x.xBeta)”； 

 Linux 系统下的云源软件是压缩包形式，名称为“云源软件 for 

Linux(Vx.x.xBeta)”； 

 Windows 系统下的浮点型 license 服务启动软件名称为“高云许可证服

务器 for Win”； 

 Linux 系统下的浮点型 license 服务启动软件是压缩包形式，名称为“高

云许可证服务器 for Linux”。 

注！ 

 软件下载前，需先注册官网并登录； 

 软件安装包/压缩包名称“Vx.x.xBeta”中“x”表示软件的版本号。

http://www.gowinsemi.cn/faq.aspx
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3 软件安装 

3.1 Windows 系统软件安装 

Windows 系统下的安装方式一致，双击云源软件安装包，根据提示安装，

安装过程中可根据需要更改安装目录，安装结束后，会默认在 PC 桌面创建

快捷方式。 

3.2 Linux 系统软件安装 

云源软件在 Linux 系统下支持的各类操作系统安装方式一致，解压文件

夹，即完成软件安装。 

3.3 软件安装注意事项 

3.3.1 Windows 系统安装 

 安装云源软件前，建议关闭 360、金山毒霸或者诺顿等杀毒软件； 

 软件安装路径尚不支持含有中文或空格的文件路径。 

3.3.2 Linux 系统安装 

 Programmer 的启动需要使用 root 权限； 

 解压文件夹后，建议使用“chmod”命令修改相关可执行文件的权限。 

3.3.3 SynplifyPro 注意事项 

 不支持双网卡的 PC； 

 不支持 32 位操作系统； 

 Windows 系统无网环境如果不能启动 SynplifyPro，请使用 whatscl 确认

证书是否过期，运行命令参考：\x.x\SynplifyPro\bin\whatscl.exe 

--check-cert，若过期，请更新证书，或者联系高云半导体 FAE 协助更新； 

 Linux 系统，若配置完环境变量后运行 SynplifyPro 仍然失败，打开

/root/.bashrc 文件，再次设置环境变量 LM_LICENSE_FILE，其值的格

式为“端口号@主机名”，终端执行 source /root/.bashrc 或重启后可生

效。 
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3.4 软件安装目录 

Windows 系统安装云源软件时，会在安装目录 path\Gowin_Vx.x.xBeta

下创建 IDE、Programmer、SynplifyPro 的安装目录及卸载云源软件的可执

行文件，如图 3-1 所示。Linux 系统云源软件安装目录没有卸载云源软件的

可执行文件，其他目录（IDE、Programmer、SynplifyPro）均与 Windows

系统相同。本节以 Windows 系统为例介绍云源软件安装目录。 

图 3-1 云源软件安装目录 

 

3.4.1 IDE 安装目录 

IDE 文件夹为云源软件的安装目录，如图 3-2 所示。bin 文件夹为可执行

文件目录，包含 gw_ide.exe、floorplanner.exe 等可执行文件，双击

bin\gw_ide.exe 可直接启动云源软件，双击 bin\floorplanner.exe 可直接启动

FloorPlanner。doc 文件夹为云源软件相关的用户指南文档。simlib 文件夹为

云源软件的仿真库。 

图 3-2 IDE 目录 

 

3.4.2 Programmer 安装目录 

Programmer 文件夹为高云云源编程器的安装目录，如图 3-3 所示。bin

文件夹为可执行文件目录，双击 bin\programmer.exe 可直接启动高云云源编

程器。 

图 3-3 Programmer 目录 

 

3.4.3 SynplifyPro 安装目录 

SynplifyPro 文件夹为 Synplify Pro 软件的安装目录，如图 3-4 所示。bin
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文件夹为可执行文件目录，双击bin\synplify_pro.exe可直接启动Synplify Pro

软件。doc 文件夹为 Synplify Pro 软件相关的参考文档。 

图 3-4 SynplifyPro 目录 

 

3.4.4 uninst.exe 

uninst.exe，卸载云源软件的可执行文件，双击 uninst.exe，弹出 Gowin 

Vx.x.xBeta Uninstall 提示框，如图 3-5 所示，点击“Yes”，即可卸载云源软

件。 

图 3-5 软件卸载 
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4 软件 License 配置 

4.1 License 简介 

4.1.1 License 定义 

软件 license 是一种格式合同，由高云半导体与用户签订，用以规定和

限制软件用户使用软件的权利，以及高云半导体应尽的义务。 

软件 license 主要包含三要素：license 类型、物理（MAC，Media Access 

Control）地址、使用期限。 

4.1.2 License 类型 

license 类型，包括节点锁定型 license(Node locked)和浮点型

license(Floating)。 

节点锁定型 license，是基于本机物理地址所获取的 license，获取节点

锁定型 license 的用户只能在锁定节点的机器上使用软件，其他机器无法使

用该 license。 

浮点型 license，是基于在局域网内搭建的 license 服务器的物理地址所

获取的 license，有用户使用数量限制，没有最大用户使用数量限制，该局域

网内的任一用户（管理员授权）都可以使用。 

4.1.3 License 使用 

Windows 操作系统及 Linux 操作系统均可使用 Node locked 或 Floating

的 license，license 具体的使用如下所述： 

1. 单个用户且拥有一台单机版 PC，license 和云源软件都安装在这台机器

上，那么，用户可以使用 Node locked license，也可以使用 Floating 的

license； 

2. 多个用户且拥有多台单机版 PC，所有 PC 在同一个局域网，每个 PC 上

都安装了云源软件，那么，可以申请 Floating 的 license。Floating 的

license 安装在局域网内一台 PC 上，各用户可以通过连接该 PC 的 IP 获

取 Floating license，如图 4-1 所示。 
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图 4-1 服务器安装 Floating license 

Floating 
License

云源软件
云源软件

云源软件

 
 

3. 多个用户且拥有多台单机版 PC（所有 PC 均是 Windows 操作系统），所

有 PC 在同一个局域网，可以申请 Floating 的 license。在 Windows 服

务器操作系统上安装云源软件及 Floating license，用户可以在自己的 PC

上登录账户（如通过远程桌面登录）访问 Windows 服务器，直接使用该

Windows 服务器上的云源软件及 license，如图 4-2 所示。 

4. 多个用户且拥有多台单机版 PC（所有 PC 均是 Windows 系统），所有

PC 在同一个局域网，可以申请 Floating 的 license。在 linux 操作系统上

安装云源软件及 Floating license，用户可以在自己的 PC 上登录账户（如

通过 Exceed onDemand Desktop 客户端登录）访问 linux 服务器，直接

使用该 linux 服务器上的云源软件及 license，如图 4-2 所示。 

5. 多个用户且拥有多台单机版 PC（所有 PC 均是 linux 操作系统），所有

PC 在同一个局域网，可以申请 Floating 的 license。在 Windows 服务

器操作系统上安装云源软件及 Floating license，用户可以在自己的 PC

上登录（如通 RDP 协议）到 Windows 服务器，直接使用该 Windows

服务器上的云源软件及 license，如图 4-2 所示。 

6. 多个用户且拥有多台单机版 PC（所有 PC 均是 linux 系统），所有 PC 在

同一个局域网，可以申请 Floating 的 license。在 linux 操作系统上安装

软件及 Floating license，用户可以在自己的 PC 上（如通过 VNC Sever）

访问 linux 服务器，直接使用该 linux 服务器上的云源软件及 license，如

图 4-2 所示。 
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图 4-2 服务器安装 Floating license 及云源软件 

云源软件及
Floating License

 

4.1.4 物理地址获取方式 

Windows 获取 MAC 地址的方式（以 Windows10 为例）： 

1. 打开“开始”菜单，选择“命令提示符”； 

2. 在命令提示符窗口中输入 ipconfig/all，按回车； 

3. 在返回的信息中即可获取物理地址，如图 4-3 红框里的信息所示。 

图 4-3 Windows10 系统 MAC 地址 

 
 

Linux 获取 MAC 地址的方式（以 Centos7.5 为例）： 

1. 打开终端；  

2. 在终端输入“/sbin/ifconfig”，按回车； 

3. 在返回的信息中即可获取物理地址，如图 4-4 红框里的信息所示。
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图 4-4 Centos7.5 系统 MAC 地址 

 

4.1.5 云源软件 License 申请 

云源软件 license 可在高云半导体的官网申请或者通过联系 FAE 直接申

请，官网申请地址：http://www.gowinsemi.com.cn/faq_view.aspx 

申请 License 的页面如图 4-5 所示。 

图 4-5 官网申请 License 页面 

 
 

license 类型：“仅本机”是 Node locked license，“共享型”是 Floating 

license。  

申请的 License 使用期限默认为一年，过期失效后可以再次申请。

Floating license 默认支持 5 个用户使用，没有最大用户使用数量限制。 

http://www.gowinsemi.com.cn/faq_view.aspx
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4.2 Windows 系统软件 License 配置 

Windows 系统的 license 配置方式一致，以 Windows10 系统为例说明。 

4.2.1 SynplifyPro license 加载 

节点锁定型 license（Node-locked） 

 节点锁定型 license 是基于本机 MAC 地址所获取的 license，仅限本

机用户使用。收到 SynplifyPro 的节点锁定型 license 后，配置环境变量即可，

变量名为“LM_LICENSE_FILE”，变量值为节点锁定型 license 绝对路径。

如图 4-6 所示。 

图 4-6 环境变量设置 

 

注！ 

如电脑中已安装的友商软件带 synplifyPro 综合工具，可能会出现 license 冲突问题，需在环

境变量里添加 SYNPLIFYPRO_LICENSE_TYPE，并设为 synplifypro_gowin ，如图 4-7 所

示。 

图 4-7 添加 SYNPLIFYPRO_LICENSE_TYPE 
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浮点型 license（Floating） 

浮点型 license 是在局域网内搭建一台 license 服务器，局域网内的 PC

都可使用。浮点型 license 会有用户数量限制，且使用浮点型 license 前需要

启动 license 服务。 

启动浮点型 license 服务的步骤如下： 

1. 安装 SCL 工具 

 点击文件夹 synplifyProLicenseStartServer 下的可执行文件

“scl_v2018.06_Windows.exe”进行 SCL 软件的安装，根据软件安

装向导步骤进行安装，在弹出的“Site Information”界面可进行如下

配置： 

- “Site ID”：获得的 SynplifyPro 的 license 文件（如

gowin_synplifyPro.lic）的“siteid”的取值，如 29247； 

- “Site Administrator”：应是本机管理员名称； 

- “Contact Information”：可选填项，管理员联系方式； 

 根据 SCL 软件安装向导选择安装路径，如选择路径

“C:\Synopsys\SCL”，点击下一步直到出现完成安装界面，如

“Completing the SCL 2018.06 Setup Wizard”，点击“Finish”按

钮完成 SCL 安装； 

2. 修改 license 文件内容 

 修改计算机名称：license 文件内容‘SERVER hostname1 

F8BC12950972 27020’一行，“hostname1”修改为本机计算机名

称；“27020”为端口号，可根据安装 SynplifyPro 的计算机信息进行

修改； 

 修改 snpslmd 路径：根据 SCL 软件中 snpslmd.exe 的路径，修改

license 文件内容‘VENDOR snpslmd /path/to/snpslmd’一行。如

修改为：VENDOR snpslmd 

C:\Synopsys\SCL\2018.06\win32\bin\snpslmd.exe。 

3. 加载 license 文件 

加载 license 文件有两种方式：SCL 命令行模式启动、SCL 界面配置模

式启动 

 SCL 命令行模式启动 

a). 打开 cmd 窗口，运行命令启动 license 服务，执行命令： 

path\lmgrd.exe -c path\licensefile -l path\logfile  

注！ 

命令解释： 

 -c：指定 license 文件； 

 -l：指定生成的 log 文件。 

b). 运行完毕后，查看 log 文件（log 文件路径：path\logfile），确认

license 是否启动成功，如启动成功，log 文件中会出现如图 4-8

所示。 
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图 4-8 License 安装成功 log 文件 

 
 

 SCL 界面配置模式启动 

a). 在 snpslmd 路径下，即启动执行文件 lmtools.exe，界面如图 4-9

所示。 

图 4-9 SCL 启动界面 

 

 

b). 选择“Config Services”页签，配置相关文件路径，如图 4-10

所示： 

- “Path to the lmgrd.exe file”：lmgrd.exe 文件所在路径； 

- “Path to the license file”：license 文件所在的路径； 

- “Path to the debug log file”：加载 license 后生成的 log

文件的路径。 
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注！ 

若无 log 文件，配置前需用户在 log 输出目录新建一个 log 文件。 

图 4-10 SCL 配置界面 

 

 

c). 配置完后，启动 license 服务，如图 4-11 所示，选择

“Start/Stop/Reread”页签，单击“Start Server”， 可在下方

显示“Server Start Successful”则代表启动成功。也可通过查

看 log 文件核查是否启动成功，点击如图 4-10 的 View Log 可查

看 log 文件。 

图 4-11 SCL 启动 license 界面 

 

注！ 
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启动 license 服务之后，同样需配置系统环境变量 LM_LICENSE_FILE 才可成功使用

SynplifyPro 浮点型 license，变量名为“LM_LICENSE_FILE”，变量值为“端口号@IP 地

址”，如图 4-12 所示。 

图 4-12 环境变量设置 

 

4.2.2 Gowin license 加载 

 云源软件安装完成后，打开云源软件时会对 license 进行检查，如果

license 不正确，软件无法启动并报出 Error 提示框，如图 4-13 所示。点击

“OK”后，弹出 license 配置窗口，如图 4-14 所示。 

图 4-13 License Error 提示框 
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图 4-14 Manage License 选项 

 
 

节点锁定型 license（Node-locked） 

第一次配置 license，可在图 4-14 窗口选择“Use Local License File”，

选择本地节点锁定型 license 文件，单击“Browse„”，添加文件的路径，单

击“Save”保存即可。 

如果用户更改 license 配置，可在云源软件界面的菜单栏上，单击“Help > 

Manage License„”，弹出“License Configuration”窗口，如图 4-14 所示，

即可更新 license 配置。 

浮点型 license（Floating） 

提供三种方式启动浮点型 license： 

 PnrLicenseStartServer 工具启动； 

 开机自动启动； 

 Windows 服务启动。 

使用 PnrLicenseStartServer 工具启动浮点型 license 服务，可通过以下

两种方式启动： 

1. 直接双击“gwlic_server.exe”启动： 

需要将浮点型 license 文件（如 gowin_license.lic）复制到

“gwlic_server.exe”所在路径下，将浮点型 license 文件改名为

“gowin.lic”，双击“gwlic_server.exe”； 

2. 命令行模式启动： 

打开 cmd 窗口，执行命令：path\gwlic_server.exe -l 

path\gowin_license.lic -b。启动后如图 4-15 所示。 

注！ 

 -l:加载 license 文件； 

 -b:后台运行 license 服务。 
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图 4-15 Gowin Floating License Server 启动界面 

  
 

启动成功之后，在“License Configuration”窗口中输入 floating license

服务器的 IP 地址，如图 4-16 所示。 

图 4-16 Floating License 配置界面 

 

 

 点击右侧“Test Connection”按钮可以测试能否连接成功，连接成功

会在 License Configuration 窗口中出现“Success”，如图 4-17 所示。 
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图 4-17 测试连接 

 
 

不管是哪种类型的 license 在配置或更新后，软件自动会将 license 配置

信息写入安装目录下的配置文件\IDE\bin\gwlicense.ini 中，如图 4-18 所示。 

图 4-18 License 配置文件 

 

注！ 

如果云源软件安装目录下的配置文件权限不足，无法保存 gwlicense.ini 文件，单击“Save”

按钮会弹出无法保存的提示。此时需要对 gwlicense.ini 文件增加允许“修改”与“写入”

的权限，即右键该文件选择属性->安全项，如图 4-19 所示。权限修改后，再次进行 license

配置。 

图 4-19 文件权限修改 
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Floating license 开机自动启动设置。以 Windows10 系统为例介绍如何

设置 Floating license 开机自动启动。 

1. 准备批处理文件 

建立后缀为.bat 的批处理文件，例如“startFloatingLicense.bat”，在文

件中写入批处理文件内容，如“start path\gwlic_server.exe -l 

path\gowin.lic –b”。 

2. 将批处理文件拷贝至启动文件夹 

打开运行对话框（win 键+R），输入命令：shell:startup，如图 4-20 所示。

按回车，弹出如图 4-21 所示的启动文件夹，将 startFloatingLicense.bat

批处理文件拷贝到该启动文件夹。 

图 4-20 运行命令 shell:startup 

 

 

图 4-21 启动文件夹 

 

 

3. 查看开机自动启动是否有效 

打开任务管理器，如图 4-22 所示，查看 startFloatingLicense.bat 为

Enabled，Floating license 开机自动启动设置成功。 
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图 4-22 任务管理器 

 
 

Windows 服务启动。以 Windows10 系统为例，介绍如何自动化创建

Windows 服务。该服务需要以管理员权限运行，并且在启动前，保证 LAN

通讯正常。 

注！ 

如果 LAN 通讯不正常，可以尝试关闭系统防火墙以防拦截程序正常的网络通讯，并使用 ping

命令测试 LAN 通讯是否正常。 

1. 服务启动 

如果是以管理员权限登录 PC，可以直接右键启动批处理文件

“gowinLicenseServiceAdded.bat”，或者以管理员的方式打开 cmd 命

令窗口，执行批处理文件“gowinLicenseServiceAdded.bat”，成功后会

有“Windows service has added successfully!”提示，如图 4-23。 

图 4-23 启动界面 

 
 

2. 服务生效，以Windows服务名称 serviceName “gowinLicenseService”

为例说明。 

 命令行生效：sc start gowinLicenseService,执行完后可以通过任务
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管理器查看状态，显示“Running”，如图 4-24； 

图 4-24 任务管理器 

 
 

 界面生效，启动任务管理器，右键 gowinLicenseService，选择“Start”，

成功后显示状态为“Running”； 

 重启系统，Windows 会自动生效 Windows 服务。 

 测试生效，使用云源软件界面 Help > License Configuration 测试创

建的服务是否生效。如图 4-25 所示，使用创建服务程序的主机 IP 地

址为 192.168.31.167，则在配置项填写 IP 地址，点击“Test 

Connection”，提示“Success”，即为 floating license 已成功启动。 

图 4-25 软件 license 配置界面 

 

注！ 

如果测试失败，可查看 license 文件所在目录的 log 文件‘gwlic_server.log’，参考失败原因。 

3. 服务终止移除 

 服务终止命令：cmd 命令窗口运行 sc stop gowinLicenseService 

 服务移除命令：cmd 命令窗口运行 sc delete gowinLicenseService 
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4.3 Linux 系统 license 配置 

Linux 系统的 license 配置方式一致，以 Ubuntu 18.04 LTS 为例说明。 

4.3.1 SynplifyPro license 加载 

 Linux 环境下的 SynplifyPro 只有浮点型 license。请参考以下步骤执行

加载过程： 

1. 安装 SCL 工具 

Linux 下的 synplifyPro 浮点型 license 服务软件是压缩包形式，解压后的

文件夹名称为“synplifyProLicenseStartServer”。 

2. 修改 license 文件内容 

 修改计算机名称：在浮点型 license 文件中，将“SERVER hostname1 

000C293B1A2B 27020”中内容 hostname1 修改为系统主机名， 

27020 为端口号，根据安装 SynplifyPro 的计算机信息进行修改。  

 修改 snpslmd 路径：根据 synplifyPro 的浮点型 license 服务软件中

snpslmd 的路径

（synplifyProLicenseStartServer/linux64/bin/snpslmd），将 license

文件中“VENDOR snpslmd /path/to/snpslmd”一行，修改为本地

snpslmd 的路径。  

3. 加载 license 文件 

使用 synplifyPro 的浮点型 license 服务软件加载 license：在 lmgrd 文件

所在路径下（synplifyProLicenseStartServer/linux64/bin）执行指

令：./lmgrd -c path/licensefile -l path/logfile，生成 log 文件，查看 log 文

件确认是否加载成功，如加载成功，log 文件中会出现如图 4-8 所示。 

注！ 

-c：指定 license 文件； 

-l：指定生成的 log 文件。 

4. 配置环境变量 

 用于所有用户，设置环境变量 LM_LICENSE_FILE，打开/etc/profile

文件，在文件中键入环境变量，其值的格式为“端口号@主机名”，

如 export LM_LICENSE_FILE=27020@gaoyun。修改文件后可以运

行 source /etc/profile，或者重启电脑，使环境变量生效。 

 用于当前用户，设置环境变量 LM_LICENSE_FILE，打开用户主目

录下的.bashrc 文件，在文件中键入环境变量，其值的格式为“端口

号@主机名”，如 export LM_LICENSE_FILE=27020@gaoyun。修

改文件后可以运行 source ~/.bashrc，或者重启电脑，使环境变量生

效。 

 用于当前终端，设置环境变量 LM_LICENSE_FILE，直接在 terminal

中运行export命令定义环境变量，其值的格式为“端口号@主机名”，

如 export LM_LICENSE_FILE=27020@gaoyun。 

 license 安装过程中，默认采用 27020 端口，用户可根据实际需求修

改为指定端口。 
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4.3.2 Gowin license 加载 

云源软件安装完成后，打开云源软件时会对 license 进行检查，如果

license 不正确，软件无法启动并报出 Error 提示框，如图 4-26 所示。点击

“OK”后，弹出 license 配置窗口，如图 4-27 所示。 

图 4-26 License Error 提示框 

 
 

图 4-27 Manage License 选项 

 

 

节点锁定型 license（Node-locked） 

第一次配置 license，可在图 4-27 窗口选择“Use Local License File”，

择本地节点锁定型 license 文件，单击“Browse„”，添加文件的路径，单击

“Save”保存即可。 

如果用户更改 license 配置，可在云源软件界面的菜单栏上，单击“Help > 

Manage License„”，弹出“License Configuration”窗口，如图 4-27 所示，

即可更新 license 配置。 

浮点型 license（Floating） 

首先使用 PnrLicenseStartServer 工具启动浮点型 license 服务。可通过

以下两种方式启动： 
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1. 双击“gwlic_server”启动： 

需要将浮点型 license 文件（如 gowin_license.lic）复制到“gwlic_server”

所在路径下，将浮点型 license 文件改名为“gowin.lic”，双击

“gwlic_server”； 

2. 命令行模式启动： 

打开 cmd 窗口，执行命令：path\gwlic_server -l path\gowin.lic。启动后

如图 4-28 所示。 

注！ 

-l：加载 license 文件； 

图 4-28 Gowin Floating License Server 启动界面 

 
 

 启动成功之后，在“License Configuration”窗口中输入 floating license

服务器的 IP 地址，如图 4-29 所示。 



4 软件 License 配置 4.3 Linux 系统 license 配置 

 

SUG501-1.1 24(27) 

 

图 4-29 Floating License 配置界面 

 
 

 点击右侧“Test Connection”按钮可以测试能否连接成功，连接成功

会在 License Configuration 窗口中出现“Success”，如图 4-30 所示。 

图 4-30 测试连接 

 
 

不管是哪种类型的 license 在配置或更新后，软件自动会将 license 配置

信息写入安装目录下的配置文件\IDE\bin\gwlicense.ini 中，如图 4-31 所示。 
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图 4-31 License 配置文件 

 

注！ 

如果云源软件安装目录下的配置文件权限不足，无法保存 gwlicense.ini 文件，单击“Save”

按钮会弹出无法保存的提示。此时需要对 gwlicense.ini 文件增加允许“写入”的权限，在

终端执行命令“chmod +x <file>”即可修改文件权限。 
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5 软件启动 

5.1 Windows 系统软件启动 

以 Windows10 系统为例说明。 

5.1.1 GUI 模式启动 

 双击快捷方式“ ”，可启动云源软件界面； 

 或进入“安装目录下\x.x\IDE\bin”，双击可执行文件“gw_ide.exe”； 

 打开 cmd 命令窗口，输入“安装目录下\x.x\IDE\bin\gw_ide.exe”，如

“E:\Gowin\Gowin_V1.9.5Beta\IDE\bin\gw_ide.exe”； 

 双击工程文件.gprj。 

5.1.2 命令行启动 

在 cmd 命令窗口，输入：path\IDE\bin\gw_sh.exe，使进入命令行控制

模式，具体 tcl 命令详见 SUG100，Gowin 云源软件用户指南的附录 A。 

5.2 Linux 系统软件启动 

以 Ubuntu 18.04 LTS 系统为例。 

5.2.1 GUI 模式启动 

 进入“安装目录下\x.x\IDE\bin”，双击可执行文件“gw_ide”。 

 在 terminal 中运行命令：path/x.x.xBeta/IDE/bin/gw_ide。 

5.2.2 命令行启动 

在 terminal 中输入命令：path/IDE/bin/gw_sh，进入命令行控制模式，

具体 tcl 命令详见 SUG100，Gowin 云源软件用户指南的附录 A。 

http://cdn.gowinsemi.com.cn/SUG100.pdf
http://cdn.gowinsemi.com.cn/SUG100.pdf
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6 软件退出 

6.1 Windows 系统软件退出 

通过以下方式退出软件： 

 单击“File > Exit”选项； 

 单击软件界面右上角图标“ ”。 

6.2 Linux 系统软件退出 

通过以下方式退出软件： 

 单击“File > Exit”选项； 

 单击软件界面右上角图标“ ”。 
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